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EntireX Workbench

The EntireX Workbench is implemented and delivered as of a set of Eclipse plug-ins. It provides
the EntireX development-time user interface in a commonly used environment. Among other
capabilities, EntireX Workbench provides various wrappers, IDL extractors, editors and testers
for generating and testing interface objects to be used in RPC communication between existing
RPC servers and RPC client applications.

This document assumes you have already installed the EntireX Workbench, using the Software
AG Installer.

Scope Lists the components of the EntireX Workbench, with links to more
information.
Supported File Types File types supported by EntireX Workbench.

Server Mapping Files for Natural Handling server mapping files for Natural in the EntireX Workbench.
Server mapping files are used at runtime to marshal and unmarshal the
RPC data stream. This document provides information on source control,
comparing etc. of server mapping files.

Server Mapping Files for COBOL Handling server mapping files for COBOL in the EntireX Workbench.
Server mapping files are used at runtime to marshal and unmarshal the
RPC data stream. This document provides information on migration,
source control, comparing etc. of server mapping files.

Server Mapping Deployment How to deploy server-side mapping files (Workbench files with extension

Wizard .svm) with the Deployment Wizard.

IDL Tester Using the EntireX IDL Tester.

Using EntireX Custom Wrappers How to define your own template-based wrappers.
Command-line Mode Using EntireX Workbench from a command line.

Storing IDL Properties Using an external file to store IDL properties for export/import.

If you are not yet familiar with Eclipse, see the Eclipse online help at
http:/lwww.eclipse.org/documentation/, or start the Software AG Designer and then choose Help >
Help Contents. General information on Eclipse can then be found under Workbench User Guide.
When working with the Software AG Designer, the online help also provides help for the currently
installed Software AG products; this can be found under Software AG Designer Guides.
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Scope of the EntireX Workbench

See also Installing the EntireX Workbench Plug-ins in Standalone Mode in the general installation
documentation.

Workbench Editors

IDL Editor
A Software AG IDL file contains definitions of the interface between client and server. The
IDL file is used by Software AG wrappers to generate RPC clients, RPC servers and tester etc.
on the basis of these definitions. The IDL file can be edited by the IDL Editor provided by plug-
ins for Eclipse.

Merging and Refactoring Software AG IDL
IDL refactoring is a process that checks all programs and structures in a single library if they
contain identical groups. All identical groups are extracted in a single structure in the same
library, and replaced with a structure reference. If a structure exists that is identical to the
structure to be created, all references will point to the existing structure and a new one will
not be created. Two groups are identical if each group has the same number and order of
parameters, and each parameter in one group has the same name and the same type as the
corresponding parameter in the other group. IDL refactoring can be performed on single or
multiple IDL files.

XML Mapping Editor

The EntireX XML Mapping Editor allows you to map XML document structures to IDL libraries,
programs and parameters. The mappings can be defined for the request and response to the
server application, or from the server to the client. The input for the XML Mapping Editor can
be a Software AG IDL file and/or an IDL-XML mapping file (perhaps produced by a previous
XML Mapping Editor session or by importing a WSDL file, XML Document or XML Schema).
The output is an IDL-XML mapping file, other XML structure definitions (such as sample XML
files), and perhaps a created or changed IDL file.
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Scope of the EntireX Workbench

EntireX Wrappers

In EntireX terms, a wrapper is a tool contained in the EntireX Workbench to generate interface
objects based on a Software AG IDL file and additional wrapping properties. The following
wrappers are provided:

COBOL Wrapper
EntireX COBOL Wrapper provides access to RPC-based components from COBOL applications.
It enables you to develop both client and server applications.

C Wrapper
EntireX C Wrapper provides access to RPC-based components from C applications. It enables
you to develop both client and server applications.

Custom Wrappers
The EntireX Custom Wrappers are user-configurable, template-based wrappers and need a
Software AG IDL file, a template (e.g., client or server) and the Software AG IDL Compiler.

DCOM Wrapper
The EntireX DCOM Wrapper generates DCOM-enabled components using RPC technology.
This so-called “wrapping” makes it possible to treat existing applications as ActiveX compon-
ents.

NET Wrapper
The EntireX .NET Wrapper provides access to RPC servers for .NET client applications and
access to .NET servers for any RPC client. The NET Wrapper generation tools of the Workbench
take as input a Software AG IDL file, which describes the interface of the RPC, and generates
C# classes that implement the methods and data types of the interface.

Wrapper for EJB
The EntireX Wrapper for Enterprise JavaBeans enables Java-based components to access an
EntireX RPC server using Enterprise JavaBeans. This is accomplished by mapping RPC server
libraries to EJB stateful session beans. A remote procedure call will be mapped to a method of
the corresponding Enterprise JavaBeans. The Java-based components can use the logic imple-
mented in the libraries of the existing RPC servers, or they can implement new logic on the
application server side, using parts of the old logic.

Java Wrapper
The EntireX Java Wrapper provides access to EntireX RPC-based components from Java ap-
plications. EntireX Java RPC enables users to develop both client and server applications
written in Java. Java applets can also be used as EntireX RPC clients.

Java Wrapper for Natural
The EntireX Java Wrapper for Natural allows you to generate EntireX Java client interface
objects from Natural subprograms in a NaturalONE project in Eclipse. The generated Java
client interface objects can be used by Java application developers to access Natural server
components, using EntireX/Natural RPC.

EntireX Workbench 3



Scope of the EntireX Workbench

Natural Wrapper
The Natural Wrapper allows you to develop Natural client applications that access RPC-based
server components, and to create Natural RPC server skeletons you can use as a basis to write
a Natural RPC server that can be accessed by RPC clients.

PL/I Wrapper
The EntireX PL/I Wrapper provides access to RPC-based components from PL/I applications.
It enables you to develop both client and server applications.

Integration Server Wrapper
The webMethods Integration Server Wrapper generates Integration Server adapter services
and listeners from a Software AG IDL file within an Integration Server connection definition.

Web Services Wrapper
The EntireX Web Services Wrapper is a wizard that generates Web services from Software AG
IDL, XML/SOAP mapping files or Natural subprogram files. The generated result is a Web
service archive (.aar) that contains the relevant artifacts of the Web service such as an
XML/SOAP mapping file (xmm), WSDL file and additional configuration files. The Web service
archive can be deployed for execution by the wizard or - in an extra deployment step - in a
Web Services Stack with the EntireX XML/SOAP Listener runtime.

Web Services Wrapper for Natural
The EntireX Web Services Wrapper for Natural allows you to develop Web Services that access
Natural server components, using EntireX/Natural RPC.

XML/SOAP Wrapper
The EntireX XML/SOAP Wrapper enables XML-based communication to EntireX/Natural RPC
servers and communication from EntireX/Natural RPC clients to XML-based servers.

4 EntireX Workbench



Scope of the EntireX Workbench

Software AG IDL Extractors

An extractor is a tool contained in the EntireX Workbench to extract a Software AG IDL file. The
following extractors are provided:

IDL Extractor for COBOL
The Software AG IDL Extractor for COBOL enables you to extract the interface of a COBOL
server and transforms it into a Software AG IDL and a Software AG server mapping file. Both
files are required to provide access for any RPC client to the COBOL server.

IDL Extractor for Natural
The Software AG IDL Extractor for Natural extracts a Software AG IDL definition from a
Natural source in a Natural project in Eclipse, or from an object within a Natural RPC environ-
ment.

IDL Extractor for PL/I
The Software AG IDL Extractor for PL/I extracts a Software AG IDL file from a PL/I source.
The PL/I source can be located in the file system or accessed remotely within a PL/I RPC envir-
onment definition.

IDL Extractor for Integration Server
The Software AG IDL Extractor for webMethods Integration Server is a wizard that reads a
package from the Integration Server and generates a Software AG IDL file from all the existing
services and nodes. Each service results in a program in the IDL file. All parameters of the
services are mapped to an IDL alphanumeric data type, available as variable (AV) or fixed
(An) length. From EntireX Adapter 9.7, mapping is described in this product's documentation.

IDL Extractor for XML Document
The Software AG IDL Extractor for XML Document generates a Software AG IDL File in the
IDL Editor documentation and a related XML mapping file (XMM) from a given XML document.

IDL Extractor for XML Schema
The Software AG IDL Extractor for XML Schema generates a Software AG IDL File in the IDL
Editor documentation and a related XML mapping file (XMM) from given XML schema files.

IDL Extractor for WSDL
The Software AG IDL Extractor for WSDL is a wizard that generates Web service client artifacts
from a WSDL file. With these artifacts, EntireX RPC client applications can access external
Web services.

EntireX Workbench 5



Scope of the EntireX Workbench

Other Components

UDDI Registration
EntireX UDDI Registration is a tool with which you can register a Web service with any UDDI
registry for which you have an account.

CentraSite Integration
Web services created with EntireX can be published to CentraSite. CentraSite offers enhanced
registry functionality, and also repository functionality that enables you to store Web services
artifacts and register interdependencies for impact analysis.

Default Broker View
The EntireX Default Broker View is part of the EntireX Workbench. It displays the status of
the EntireX Default Broker and the active RPC Services registered to it.

6 EntireX Workbench
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Supported File Types

Input Files

The following table lists the file types that the EntireX Workbench can use as input. Some of the
file types may have different content. The content determines which files you can generate. The
actions in the context menu depend on the file type.

File Type

Content

Generated Files

cvim

Client-side mapping file that completes the related IDL of the
same name with server mapping information to successfully
call the target RPC server customer program. Contains COBOL
mapping (see Server Mapping Files for COBOL) or Natural

mapping.

idl Software AG IDL for RPC, see Software AG IDL File in the IDL|C client, C server, Java client, Java
Editor documentation. server, Java tester, COBOL client,
COBOL server, C# client, DCOM
object, XMM file, PL/I client, PL/I
server.
svm Server-side mapping file that completes the related IDL of the
same name with server mapping information to successfully
call the target RPC server customer program. Contains COBOL
mapping; see Server Mapping Files for COBOL.
wsdl  |Web service description file. IDL file, XMM mapping file.
xml XML document. IDL file, XMM mapping file.
xmm |EntireX XMM file with element mapping.
xmm |EntireX XMM file with attribute mapping.
xmm  |EntireX XMM file with user-defined mapping.
xmm  |EntireX XMM file with SOAP mapping. WSDL file.
xsd XML Schema file. IDL file, XMM mapping file.

Output Files

The following table lists the file types generated by the EntireX Workbench.

EntireX Workbench




Supported File Types

File Type |Content Generated from
aar Service archive for Web Services Stack. IDL file with XML mapping.
cvm Client-side mapping file (Natural | COBOL) that completes [COBOL source; Natural source.
the related IDL of the same name with server mapping
information to successfully call the target RPC server
customer program.
idl Software AG IDL for RPC. Import XSD, import XML, import
WSDL.
svm Server-side mapping file (COBOL) that completes the related | COBOL source.
IDL of the same name with server mapping information to
successfully call the target RPC server customer program.
Contains COBOL mapping.
wsdl  |Web service description file. IDL file.
xml XML document as test document for the XML Tester. IDL file.
xmm  |EntireX XMM file with element mapping. IDL file with XML mapping.
xmm  |EntireX XMM file with attribute mapping. IDL file with XML mapping.
xmm  |EntireX XMM file with user-defined mapping. IDL file with XML mapping.
xmm  |EntireX XMM file with SOAP mapping. IDL file with XML mapping.

EntireX Workbench
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Server Mapping Files for Natural

Server mapping enables the RPC server to correctly support special Natural syntax such as
REDEFINEs, special Natural Mapping Editor operations, etc. If one of these elements is used the
IDL Extractor for Natural automatically extracts a server mapping file in addition to the IDL file
(interface definition language). Also the Natural Wrapper may generate a server mapping file for
RPC server generation. The server mapping file is used at runtime to marshal and unmarshal the
RPC data stream. Client-side mapping files (EntireX Workbench files with extension .cvm) are
used for Natural only.

Server Mapping Files in the EntireX Workbench

The server mapping file for Natural in the EntireX Workbench is of type client-side. There are no
server-side mapping files as with COBOL.

12 EntireX Workbench



Server Mapping Files for Natural

Client-side Mapping

Client
i RPC Matural
Interface / - >
Object Server
r'y r'y

-

Programming [

i ‘= - | Client-side
language W [ W ;
neutral mapping I on Qe mapping

__.z y

The following rules apply to a server mapping file for Natural:

® The mapping file is of type client-side. There are no server-side mapping files as with COBOL.
® Mapping files have the extension .cvm.

® The mapping file has to relate to an appropriate IDL file. Always keep the IDL file and the
mapping file together in the same folder.

® The mapping file is created if required by the Natural Wrapper | Extractor. See When is a
Server Mapping File Required?.

® If an IDL file has a corresponding mapping file, at least one of the IDL programs in the IDL file
requires server-mapping information to correctly call the target server. For those IDL programs,
there is a server mapping (corresponding to a line) in the server mapping file.

= If there is an IDL file but no corresponding mapping file, there is no IDL program that requires
server mapping information.

When is a Server Mapping File Required?

IDL Extractor for Natural

Natural Syntax | Natural Mapping Editor | Server Mapping Regired |More Information

EntireX Workbench 13



Server Mapping Files for Natural

Natural Wrapper

Server Mapping
Natural Wrapper Required

More Information

IDL program name is not a valid Natural |yes
name and is therefore adapted, or the
Natural program name is customized

Step 2: Customize Natural Server Names
under Using the Natural Wrapper for the
Server Side within Natural ONE

Source Control of Server Mapping Files

Because server mapping files (EntireX Workbench files with extension .cvm) contain text data
only, a server mapping file is text-based (although it is not intended for human consumption).
Therefore, you can include it in your source control management together with the IDL file and
the Natural source(s) as a triplet that should always be kept in sync.

Comparing Server Mapping Files

For server mapping files (EntireX Workbench files with extension .cvm), you can use a third party

file/text compare tool to check if two files are identical.

A server mapping entry (corresponding to a line in a server mapping file) contains a creation
timestamp at offset 276 (decimal) in the format VY YMMDDHHIISST. The precisionis 1/10 of a second.

14
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Server Mapping Files for COBOL

Server mapping enables the RPC server to correctly support special COBOL syntax such as
REDEFINEs, SIGN LEADING and OCCURS DEPENDING ON clauses, LEVEL-88 fields, etc. If one of these
elements is used, the IDL Extractor for COBOL automatically extracts a server mapping file in
addition to the IDL file (interface definition language). Also, the COBOL Wrapper may generate
a server mapping file for RPC server generation. The server mapping is used at runtime to marshal
and unmarshal the RPC data stream. There are client-side mapping files (EntireX Workbench files
with extension .cvm) and server-side mapping files (Workbench files with extension .svm). If you
have not used server-side mapping, we recommend you use client-side mapping.

See also Server-side Mapping Files in the respective sections of the documentation.

Server Mapping Files in the EntireX Workbench

This section covers the following topics:

= |ntroduction
= Client-side Mapping
= Server-side Mapping

Introduction

The following rules apply to a server mapping file for COBOL in the EntireX Workbench:

* The mapping file is of type client-side or server-side. Use one type or the other; they cannot be
combined. See How to Set the Type of Server Mapping Files.

® Mapping files have the extension .cvm or .svm.

* The mapping file has to relate to an appropriate IDL file. Always keep the IDL file and the
mapping file together in the same folder.

® The mapping file is created if required by the COBOL Wrapper | Extractor. See When is a
Server Mapping File Required?.

® If an IDL file has a corresponding mapping file, at least one of the IDL programs in the IDL file
requires server-mapping information to correctly call the target server. For those IDL programs,
there is a server mapping (corresponding to a line) in the server mapping file.

= If there is an IDL file but no corresponding mapping file, there is no IDL program that requires
server mapping information.

16 EntireX Workbench



Server Mapping Files for COBOL

Client-side Mapping
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The following rules apply to client-side mapping;:

Client-side mapping files have the extension .cvm in the EntireX Workbench.

The mapping files are generated when the EntireX Workbench is in client-side mapping mode,
see How to Set the Type of Server Mapping Files.

Handling of client-side mapping is easier than server-side mapping. This can be an important
criterion, for example if the RPC server is hosted in a mainframe environment and you do not
have access to mainframe development resources. The following tasks are not required:

® deploying the server mapping files to the RPC server
" setting up a server-side mapping container in the mainframe environment
® change management of server-side mapping files in the mainframe environment

The mapping is wrapped into the client interface objects when an RPC client is generated. The
client-side mapping must available before you creating any RPC client component, that is, the
COBOL server program must be extracted or generated first.

The mapping is sent during runtime to the target RPC server with the RPC request.

Only point-to-point connections are allowed. The RPC client with the client-side mapping in its
client interface object can only call one specific target COBOL server program. If you want to
replace the COBOL server program by another implementation, for example Java, you need to
rebuild all the RPC clients without the client-side mapping wrapped into their client interface
object.

Client-side mapping files are not supported by RPC clients generated with the DCOM Wrapper
and COBOL Wrapper. Use server-side mapping files instead. See Server-side Mapping.

To use client-side mapping, all EntireX components involved must be version 9.7 or higher.

EntireX Workbench 17



Server Mapping Files for COBOL

Server-side Mapping
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The following rules apply to server-side mapping;:

" Server-side mapping files have the extension .svm in the EntireX Workbench.

® The files are generated when the workbench is in server-side mapping mode, see How to Set
the Type of Server Mapping Files.

® The files have to be deployed to the RPC server. See Deploying Server-side Mapping Files to the
RPC Server in the respective sections of the documentation.

| Note: For IMS Connect and CICS ECI connections with the webMethods EntireX Adapter

for Integration Server, server-side mapping files are not deployed. They are wrapped
into the Integration Server connection - the same as client-side mapping files. For RPC
connections, the server-side mapping files must be deployed to the target RPC server.
See the EntireX Adapter documentation under http://documentation.softwareag.com >
webMethods Product Line.

® Server-side mapping is read at runtime by the RPC server from the server-side mapping con-
tainer, see Server-side Mapping Files in the RPC Server in the respective sections of the document-
ation

* Flexible connections are possible: the RPC client can call any target server program as long as
the IDL interface matches. You do not need to rebuild the RPC clients when replacing the COBOL
server program by a different implementation, for example Java, as required with client-side
mapping files.

" Server-side mapping files can be migrated to client-side mapping files, see Migrating Server
Mapping Files.
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Server Mapping Files for COBOL

How to Set the Type of Server Mapping Files

Every EntireX Workbench (Eclipse) workspace is either in client-side mapping mode (generating
EntireX Workbench server mapping files with extension .cvm) or server-side mapping mode
(generating workbench server mapping files with extension .svm) for COBOL mapping. If this
decision has not yet been taken for a workspace and the COBOL Wrapper | Extractor is called,
you are prompted with the following pop-up to choose the type for COBOL mapping:

IDL Extractor for COBOL - Mapping Editor =5
. .
Choose type of COBOL Mapping
COBOL server programs may need mapping data in addition to the interface description in the IDL file. ﬂ

There are two types of mapping: client-side mapping and server-side mapping.

Client-side mapping is sent by the RPC client to the RPC server. This type of COBOL mapping is used by the wrapper for the RPC clients.

It is recommended to use client-side mapping. Server-side mapping can be migrated to client-side mapping.

Server-side mapping is deployed to the RPC server in several ways. This deployment is an additicnal manual step for some RPC servers.

Previous EntireX versions support only this type of COBOL mapping. If you want to stay with server-side mapping, choose server-side mapping below,
For further information refer to the workbench documentation,

T

Files with client-side mapping have the extension .cvm
_ Server-side Mapping

Files with server-side mapping have the extension .svm

= 2
'\‘?_,' 0K Cancel

For more information on handling the different types of COBOL mapping, see Server Mapping
Files in the EntireX Workbench.

In client-side mapping mode, it is not possible to modify server-side mapping files (EntireX
Workbench files with extension .svm). This means that if there is a related server-side mapping
file available for an IDL file, you cannot use the

® IDL Extractor for COBOL to extract an additional interface or modify an existing one

® COBOL Wrapper to generate an RPC Server
You have to migrate the server-side mapping files first. See Migrating Server Mapping Files.

In server-side mapping mode, it is not possible to modify client-side mapping files (EntireX
Workbench files with extension .cvm). This means that if there is a related client-side mapping
file available for an IDL file, you cannot use the

® IDL Extractor for COBOL to extract an additional interface or modify an existing one

EntireX Workbench 19



Server Mapping Files for COBOL

® COBOL Wrapper to generate an RPC Server

Later on, you can readjust the mode in the Preferences of the respective tool. See IDL Extractor for
COBOL Preferences or Generation Settings - Preferences in the COBOL Wrapper documentation.

When is a Server Mapping File Required?

= |DL Extractor for COBOL
= COBOL Wrapper

IDL Extractor for COBOL

A server mapping file (workbench file with extension .cvm or .svm) is generated by the IDL Ex-
tractor for COBOL if the COBOL server program is of a specific interface type, contains specific
COBOL syntax, or the IDL interface is redesigned (Suppress, Set constant, etc.) in the COBOL
Mapping Editor. The type of server mapping (server-side with extension .svm or client-side with
extension .cvim) is defined in a preference that applies to the entire EntireX Workbench (Eclipse)
workspace. See How to Set the Type of Server Mapping Files.

COBOL Server
Mapping Mapping
Interface Type COBOL Syntax Editor Required |More Information
CICS with all yes CICS with DFHCOMMAREA Calling
DFHCOMMAREA Convention under Introduction to the IDL
Calling Convention and Extractor for COBOL | CICS with
In different to Out DFHCOMMAREA Calling Convention - In
different to Out under COBOL Mapping
Editor in the IDL Extractor for COBOL
documentation
CICS Channel Container |all yes CICS with Channel Container Calling
Calling Convention Convention
CICS with all yes CICS with DFHCOMMAREA Large Buffer
DFHCOMMAREA Large Interface
Buffer Interface
IMS MPP Message all yes IMS MPP Message Interface (IMS
Interface (IMS Connect) Connect)
IMS BMP with Standard |all yes IMS BMP with Standard Linkage Calling
Linkage Calling Convention
Convention
Micro Focus with BINARY clause yes Micro Focus with Standard Linkage Calling
Standard Linkage Calling Convention
Convention
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COBOL Server
Mapping Mapping
Interface Type COBOL Syntax Editor Required |More Information
all 0CCURS yes Tables with Variable Size - DEPENDING
DEPENDING ON ON Clause under COBOL to IDL Mapping
clause in the IDL Extractor for COBOL
documentation
all REDEFINES clause yes REDEFINE Clause
all TRAILING yes SIGN LEADINGand TRAILING
[SEPARATE] SEPARATE Clause
clause
all LEADING yes SIGN LEADINGand TRAILING
[SEPARATE] SEPARATE Clause
clause
all ALIGNED RIGHT yes
attribute
all all Rename of |yes COBOL Mapping Editor
program
all all Set to yes COBOL Mapping Editor
constant
all all Suppress |yes COBOL Mapping Editor
other combinations no
COBOL Wrapper

A server mapping file (EntireX Workbench file with extension .cvm or .svm) is generated by the
COBOL Wrapper if an RPC server is generated " and at least one IDL program meets the criteria
in the table below. The type of server mapping (server-side with extension .svm or client-side with
extension .cvim) is defined in a preference that applies to the entire EntireX Workbench (Eclipse)

workspace. See How to Set the Type of Server Mapping Files.

Server

Mapping
Interface Type IDL Type COBOL Wrapper  |Required |More Information
CICS with all yes CICS with DFHCOMMAREA Large Buffer
DFHCOMMAREA Interface under COBOL Server Interface
Large Buffer Interface Types in the COBOL Wrapper

documentation

CICS with Channel |all yes CICS with Channel Container Calling
Container Calling Convention
Convention
IMS BMP with all yes IMS BMP with Standard Linkage Calling
Standard Linkage Convention
Calling Convention

EntireX Workbench
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Server
Mapping
Interface Type IDL Type COBOL Wrapper  |Required |More Information
Micro Focus [2orl4 yes Micro Focus with Standard Linkage Calling
Convention | IDL Data Types under Software
AG IDL File in the IDL Editor
documentation
all IDL yes array-definitionunder Software AG
unbounded IDL Grammar in the IDL Editor
array documentation
all IDL yes group-parameter-definition under
unbounded Software AG IDL Grammar in the IDL Editor
group documentation
all all IDL program yes Customize Automatically Generated Server
name is not a Names under Generating COBOL Source
valid COBOL Files from Software AG IDL Files in the
name and is COBOL Wrapper documentation
therefore adapted,
or the COBOL
program name is
customized
other combinations no

@ Server mapping files are never generated for RPC clients.

Migrating Server Mapping Files

This section covers the following topics:

= |ntroduction
= Step 1: Rename the Server-side Mapping File

= Step 2: Remove the Server-side Mapping Files on Target RPC Server

22
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= Step 3: Rebuild and Deploy all RPC Clients
Introduction

Server-side mapping files (EntireX Workbench files with extension .svm) can be migrated to client-
side mapping files (EntireX Workbench files with extension .cvm).

| Note: Client-side mapping files are not supported by RPC clients generated with the DCOM
Wrapper and COBOL Wrapper.

All EntireX components involved in the migration must be version 9.7 or higher:

= the target RPC server z/OS (CICS | Batch | IMS), CICS ECI, IMS Connect, Micro Focus)

® the webMethods EntireX Adapter. See EntireX Adapter documentation under http://document-
ation.softwareag.com > webMethods Product Line

" the RPC client runtimes
Step 1: Rename the Server-side Mapping File

Rename the extension .svm to .cvm in the EntireX Workbench. This results in a client-side mapping
file.

Step 2: Remove the Server-side Mapping Files on Target RPC Server

Remove the server-side mapping files in the server-side mapping container of the target RPC
server. See Undeploying Server-side Mapping Files to the RPC Server in the respective sections of the
documentation.

| Note: For IMS Connect and CICS ECI connections with webMethods EntireX Adapter for
Integration Server, this step is not required.

Step 3: Rebuild and Deploy all RPC Clients

1. Re-create (wrap, build, compile etc.) all involved RPC clients * using the related IDL file to
wrap the client-side mapping files into the client interface objects. See EntireX Wrappers.

2. Test the RPC clients with client-side mapping files.
3. If necessary, re-deploy the RPC clients with client-side mapping files.

@ This includes all variants of RPC connections of the webMethods EntireX Adapter. See webMeth-
ods Integration Server Wrapper.
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Source Control of Server Mapping Files

Because server mapping files (EntireX Workbench files with extension .cvm or .svm) contain text
data only, a server mapping file is text-based (although it is not intended for human consumption).
Therefore, you can include it in your source control management together with the IDL file and
the COBOL source(s) as a triplet that should always be kept in sync.

Comparing Server Mapping Files

For server mapping files (EntireX Workbench files with extension .cvm or .svm), you can use a
third party file/text compare tool to check if two files are identical.

A server mapping entry (corresponding to a line in a server mapping file) contains a creation
timestamp at offset 276 (decimal) in the format VY YMMDDHHIISST. The precisionis 1/10 of a second.
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= |ntroduction ............
®USING .o
= Preferences ...........

= Command-line Mode
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See also Deploying Server-side Mapping Files to the RPC Server for CICS ECI | IMS Connect.

| Note: To deploy server mapping files to the webMethods EntireX Adapter you need to update

your Adapter connection. See Step 3: Select the Connection Type in the Integration Server
Wrapper documentation.
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Introduction
| Can be z/05, Micro Focus,
Workbench 2 D or '_,'NSE Server-side
server-side ™. mapping
mapping i Deploy with Wizard - l:nni_alne
# \ | " RREC | write .
SVM > Deployment Wizard =~~~ RPC . > o

Deploying with the wizard requires an active RPC server. Also, the Deployment Service of the
RPC server must be properly configured. See the platform-specific documentation for more in-
formation:

= z/OS, see Deployment Service in the respective RPC server documentation.

® UNIX or Windows for Micro Focus COBOL, see Deployment Service in the Micro Focus RPC
Server.

® BS52000/OSD, see Deployment Service in the BS2000/OSD Batch RPC Server documentation.

= z/VSE, see Deployment Service in the respective RPC server documentation.

Using

To deploy a server-side mapping file with the wizard, follow the steps below:

= Step 1: Start the Wizard

= Step 2a: Create a New Deployment Environment

= Step 2b: Define the Connection to the Deployment Service and Deploy
= Step 3: Select and Existing Deployment Environment and Deploy

A server-side mapping file is an EntireX Workbench file with extension .svm. See Server Mapping
Files for COBOL.

EntireX Workbench 27



Server Mapping Deployment Wizard

Step 1: Start the Wizard

To start the Server Mapping Deployment Wizard, select a server-side mapping file and from the
context menu choose Deploy/Synchronize Server Mapping.... Alternatively, you can use the
context menu of the IDL file and choose COBOL > Deploy/Synchronize Server Mapping....

7= EntireX - Software AG Designer

File Edit Mavigate Search Project Run Window Help

 Ci- A R

B | Entire: | {75 Resource

= [=F Demo
= copybooks
K| .project
[ CusTINFG.id
il CLISTINFO, s

Mew
Open
Open With

3= Copy

¥ Delete
Mowe, .,
Rename..,

E2q Import...
£ Export...

& | Refresh
Walidake
Run As
Debug As
Profile As
Tearn

Compare With
Replace YWwith

IPA Tools

Properties

U7 Mavigakor 23 =8

Deploy)Synchronize Server Mapping. ..

T vy ¥ v v v

To continue, press Next with one of the following choices:

* If you are using the Server Mapping Deployment Wizard for first time with no predefined de-
ployment environment preferences, continue with Step 2a: Create a New Deployment Environ-

ment below.
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® If deployment environments are already defined, you may also continue with Step 3: Select and
Existing Deployment Environment and Deploy.

Step 2a: Create a New Deployment Environment

If no deployment environments are defined, you only have the option to create a new deployment
environment.

7= Server Mapping Deployment |:|E]
Choose Deployment Environment and Deploy/Synchronize
=

The server mapping will be deployed/synchronized using the selected deployment environment,

(%) Create a new deplovment environment

() Choose an existing deplayment environment

Zancel

Select Create a new deployment environment and press Next to continue with Step 2b: Define
the Connection to the Deployment Service and Deploy.

Step 2b: Define the Connection to the Deployment Service and Deploy

Use this page to define a connection to the deployment service of the RPC server.
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7= Server Mapping Deployment

Remote Deployment Environment

Define the connection to the deplovment service to push server mapping files

Broker Parameters

Broker I0: ¥ ibm2:6025

Server Address’| RPCIBATCH/DEPLOYMENT]

Enkirel suthentication RPZ Server duthentication

User ID: | RPC User ID: |

Passward: | RPC Password: |

Filter Settings
Timeout (Seconds); | NN

Enter the required fields:
1. Broker Parameters Broker ID and Server Address, which will have the default format. The last
part (broker service) of the server address must always be "DEPLOYMENT".

2. The EntireX Authentication parameters describe the settings for the broker. These parameters
apply if the broker is running with EntireX Security. See Which EntireX Security Solution.

3. The RPC Server Authentication parameters describe the settings for the RPC server. These
parameters apply if the RPC server is running with security. See Impersonation in the respective
RPC Server documentation.

4. The given Timeout value must be in the range from 1 to 9999 seconds (default: 60).

Press Finish to deploy. Deployment of the server mapping is successful if the wizard ends. No
confirmation message is given.
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Step 3: Select and Existing Deployment Environment and Deploy

Use this page to select the deployment environment (i.e. the RPC server) to which you want to
deploy.

7= Server Mapping Deployment |._|@@
. . .

Choose Deployment Environment and Deploy/Synchronize pu

The server mapping will be deploved|synchronized using the selected deployment ervironment,

() Create a new deployment environment

() hoose an existing deplovment environment:

=1 ibmz: E0ZS@RPCBATCH/DEPLOYMENT
5 ibmz  BOZS@RPC/CICS [DEPLOYMENT

[ I Madify the selected deployment environment

@:‘ Finish ] [ Cancel

Check the option Choose an existing deployment environment and select a deployment environ-
ment from the list. Press Finish to deploy. Deployment is successful if the wizard ends. No con-
firmation message is given.

Preferences

In the preferences for the Server Mapping Deployment Wizard you define deployment environ-
ments, a connection to the Deployment Service of the RPC server. See Deployment Service in the
respective RPC server sections of the documentation The following sections are offered:

= Create a New Deployment Environment
= Edit an Existing Deployment Environment
= Remove an Existing Deployment Environment

The deployment environment is managed from the deployment environment Preferences page.

The deployment environments can be created, edited and removed. The deployment environment
will be used for the selection lists in the Deployment Wizard. To manage these deployment envir-
onments, open the Preferences page:
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& Preferences |:|E]

|t~;.-'|:ue filker bext |

InstallfUpdate

Java

Plug-in Development

Fun/Debug

Software AG

[=- Entirex
MET ‘Wrapper
C Wrapper
COBOL Wrapper
Custorn Wrapper
DCOM Wrapper
Deplovment Enviror
EJE Wrapper
I0L Extractor For CC
I0L Extractor For Mz
10L Extractor For PL
IDL Extractor For W
Installation
Java Wrapper
PLJT Wrapper
RPC Enviranments
Weh Service Wrapp
%ML Mapping Editor

UDDI Registries
Web Services Stack

[0 B -

Deployment Environments

Manage Deplovment Environments

Table of defined Deployment Environments:

L -

Marmne

@RPCIEATCHIDEPLOYMEMT

Insert. ..

Edit. ..

ldd

Remove

Team E
< | >
7 (a4 l [ Cancel
Create a New Deployment Environment
» To create a new deployment environment
m  Press Insert.
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& Server Mapping Deployment Ef@
i

Remote Deployment Environment
=

Define the connection ko the deployment service to push server mapping files

Broker Parameters

Braker 1D ibr2: 6025

Server Address | RPC/BATCHDEPLOYMENT | Edit. ..

Enkirer authenticakion FPC Server Authenktication

ser IO RPZ User ID:

Password: RPC Password:

Filker Settings

Timeout {Seconds):

| < Back. Mext = Finish | | iZancel

Edit an Existing Deployment Environment

» To edit an existing deployment environment

m  Select the table row and press Edit. If multiple entries are selected, the first entry is used.
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& Deployment Environments

Deployment Environment -
Edit and update the deployment environment
Broker Parameters
Broker ID: | bm3:6782 |
Server fddress | RPC/CICS/DEPLOYMENT | [Edt..
Entirer Authentication RPC Server Authentication
User ID: | | RPCUseriD: | |
Passward: | | RPiC Passward: | |

Filker Settings
Timeout (Seconds): | a0 |

) 4 H Cancel ]

Remove an Existing Deployment Environment

» To remove an existing deployment environment

m  Select the table row and press Remove. Multiple selections are possible.

Command-line Mode

The command -deploy:cobol is provided to deploy mapping information contained in server-
side mapping files, using the EntireX Workbench in command-line mode. See Using the EntireX
Workbench in Command-line Mode for general information.

To undeploy previously deployed server mapping information, remove the server-side mapping
file (.svm) and execute the command -deploy:cobol with the IDL file only.

This section covers the following topics:

= Command-line Options
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= Example

Command-line Options

Task Command

Option

Description

Deploy|-deploy:cobol
SVM
files.

-environment

Target environment. Name of the COBOL deployment
environment or an RPC server description.

-brokeruser User used for broker authentication (optional).
-brokerpassword|Password used for broker authentication (optional).
-rpcuser User used for RPC server authentication (optional).
-rpcpassword Password used for RPC server authentication (optional).

| Note: Run the command from the directory containing the IDL file and the corresponding

server-side mapping file (.svm). If no server-side mapping file is found, the previously de-
ployed server mapping information related to the IDL file will be removed on the server

side (undeployed). See Undeploying Server-side Mapping Files to the RPC Server in the respective
sections of the documentation.

Example

-deploy:cobol /SVMDeployTests/idIs/basicodo.idl /SVMDeployTests/idls/basicdt.idl <«
/SUMDeployTests/idls/basicarr.idl
-environment ibm2:3980@RPC/RPCALL/DEPLOYMENT

-brokeruser EXXUSR1

-brokerpassword EXX$PWDI

EntireX Workbench
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6 EntireX IDL Tester

= ntroduction ...........cocvieiiiii
= Calling the IDL Tester .........ccccccevivvennnnn
= Using a Broker with EntireX Security ......

= Using RPC Servers with Natural Security
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| Note: The Java Wrapper also provides a method of testing IDL files. This method was

available in earlier EntireX versions and is useful if you need to generate test classes into a
Java project. See Using the IDL Tester under Using the Java Wrapper.

Introduction

The IDL Tester is an easy-to-use utility to check the accessibility of the Web service from the EntireX
Broker via the XML/SOAP RPC server. It acts as an RPC client application, taking as input an IDL
file. It verifies the mapping of the RPC data to the Web services data in the XML/SOAP mapping
file.

Calling the IDL Tester

» To call the IDL Tester

m  SelectanIDL file, and from the context menu, choose Software AG IDL Tester. This launches
the IDL Tester.

£ EntireX IDL Tester for calc EHE@
File Help

Broker: | localhost: 1971 | Server: | RPC/SR¥1/CALLNAT |
| cal ][ Ping ][ Open Conversation ] [ Resat ][ Exit ]

Messages

1 Function_Result (14)

The dialog contains fields for Broker ID and server address and buttons, a message area for gen-
eral output and error messages, and a parameter area with the input and output parameters. The
fields for the input parameters have a white background and the fields for the output parameters
are disabled and have a gray background.
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Broker ID and server address are displayed as specified in the properties of the IDL file; they can
be modified. To modify the server address, it is sufficient to enter the server; RPC/CALLNAT will
be added automatically.

Button Explanation
Call Perform the remote procedure call.
Ping Ping the broker and the RPC server.

Open Conversation |Open a conversational RPC (only visible if no conversation is open).

Commit Conversation |Close the conversational RPC and commit the conversation (only visible after Open
Conversation).

Abort Conversation |Close the conversational RPC and abort the conversation (only visible after Open

Conversation).
Reset Reset the message area and the parameters.
Exit Exit the IDL Tester.

The bottom of the dialog contains text fields for the parameters of the Software AG IDL file. These
fields are prefixed with the group level, field name and type. IN and INOUT parameters can be edited,
0UT parameters cannot be modified. The fields for INOUT and OUT parameters are updated after a
successful call. Array elements must be separated by a semicolon. The last array element behind
a semicolon will be used to fill up the array completely, e.g. (I4/5) and value 1;2 results in 1;2;2;2;2,
but value 1;2; results in 1;2;;;.

The File Menu contains the entries Options and Exit. The Options dialog allows setting user and
password for the Broker Authentication. In addition, for communication with Natural RPC Server,
the Natural library can be set and if Natural logon is enabled, user ID and password for RPC Au-
thentication can be set.
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!

Options
Braoker Authentication

Lser:
Makural

]

Matural Library:
[ ] Matural Logon
RPC User ID:

RPC Passwaord:

2 L

Trace
Tracelevel: w
[ Ok, ] [ Cancel ]

» To execute the remote call via EntireX Broker

= Use the Call button or press Return in one of the input parameter fields.

If the Broker returns errors (a BrokerException is thrown), the error message is displayed in the

Messages area.

» To ping the Broker and the RPC server

»  Use the Ping button.

» To delete the entries in the message area and the parameter fields

s Use the Reset button.
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Using a Broker with EntireX Security

When using a Broker which runs with EntireX Security, modify user ID and password accordingly.

Using RPC Servers with Natural Security

When using Natural Security, enable Natural logon and set the user ID and the password.
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7 Using EntireX Custom Wrappers

m Define EntireX CUSIOM WIAPPETS .....eiiiiiiiiiiiiiie et e e e e e e

= Running a Custom Wrapper
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The EntireX Custom Wrappers are user-configurable, template-based wrappers and need:

® a Software AG IDL file

® atemplate (for example, client or server)

® the IDL Compiler

Naturally, existing .plugin files from former EntireX installations, called EntireX Workbench Plug-
ins, can be migrated. The Custom Wrapper definitions are stored in the current Eclipse workspace

and can be managed in the preferences. Any changes in the Custom Wrapper definitions require
a restart of the Workbench to take effect. This chapter covers the following topics:

Define EntireX Custom Wrappers

The EntireX Custom Wrappers are managed in the Custom Wrapper preferences page.

The central panel lists all known (active or inactive) Custom Wrappers, that is, all Custom Wrappers
that are found in the current workspace. You can create a new empty Custom Wrapper, copy, edit
or remove an existing Custom Wrapper or migrate your existing .plugin file from a former EntireX
installation.

= Creating a New Custom Wrapper
= Parameters

= Parameter Values

= Wildcards
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.H Preferences -l —
| type filter text | Custom Wrapper g T w
EntireX -
4 I.rl'\ll:—I'Wrapper Manage the EntireX Customn Wrappers.
C Wrapper Table of defined Custom Wrappers:
COBOL Wrapper Marme - T
Custom Wrapper u
DCOM Wrapper | Duplicate |
Deployment Environments ——
EIB Wrapper |Ed'—t|
IDL Extractor for COBOL | B |
[ IDL Extractor for Natural R
[ IDL Extractor for PL/T
Installation
Integration Servers
Java Wrapper
Natural Wrapper
PL/T Wrapper MS Visual Studic Directory: Browse...
RPC Environments . ] .
Web Service Wrapper M5 Visual Studie IDE Directory: Browse..
XML Mapping Editor o MS .NET Framework Directory: Browse..
' 1 | »
@ ok [ cancel |

Creating a New Custom Wrapper

» To create a new Custom Wrapper

1 Choose Insert...

EntireX Workbench
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& EntireX Custom Wrapper. El
i

New Custom Wrapper -

Create a new Entirex Cuskomn Wrapper.,

Tame: | JE| |

Author and Copyright: | |

Template: | plugin.tpl | Browse. ..

Command; | |
Options: | |
Parameter Description Twpe Twpe Walues Parameter ... Global add. .
@ Ok ] [ Cancel ]

2 Enter the fields. The Name is a required field and must be unique, because it is the identifier
for the Custom Wrapper. This name occurs on the Custom Wrapper Properties page and will
be used for the command line with the prefix minus sign.

Field Description

Name Used as the Custom Wrapper menu item text.

Author and copyright |Important if you want to share your Custom Wrapper with other users.

Template Name of the template file to be used by the Software AG IDL Compiler in the
IDL Editor documentation. Use a fully qualified file name.

Command Executable command file name. Default is empty and means the Software AG
IDL Compiler in the IDL Editor documentation will be executed.

Options Batch parameters. They are sent to the Software AG IDL Compiler in the IDL
Editor documentation.

Parameter Parameters (constant or modifiable) to call the Custom Wrapper.

3 Optionally, add some parameters as described in the following sections.

» To add parameters

s Choose Add...

A new dialog with default values is displayed. See section Parameters for a description of
the individual fields. Modifiable parameters automatically appear with an appropriate label
and GUI widget on the Custom Wrapper IDL properties tab.
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& Custom Wrapper E|
Add new Parameter -
&dd new Parameter =
Parameter Name: | |
Description: | |
Type: |C0nstant ' |
Type Yalues: | |
Parameter Yalue: | |
Global; |true “ |
@ K l [ Cancel ]

» To edit parameters (see Parameters)
1  Select the parameter to edit in the table.
2 Choose Edit...
or
Double click on the parameter in the table.

A new dialog with the current parameter values is displayed. See section Parameters for a
description of the individual fields. For all strings in the fields Type Values and Parameter
Value, you can also use wildcards. Wildcards are like variables for actual values that may
change with the platform or in other properties tabs. See the list of Wildcards.

3 Choose OK to save your entries and close the dialog or Cancel to close the dialog without
saving.

» To remove parameters

1  Select the parameters to remove in the table.

2 Choose Remove.

Multiple selections are possible.

» To change the parameter order

1 Select the parameter to edit in the table.
2 Use the Up and Down buttons to change the order of the parameters.
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Custom Wrappers

Parameters

Parameters

consist of the following fields:

Field Purpose

Parameter The parameter identifier, as required by the erxidl template (must not contain whitespace
characters; often in uppercase).

Description The textual description of this parameter, as displayed in the associated Custom Wrapper
IDL properties tab. Human-readable, may contain whitespace characters and short
examples.

Type Dialog box of possible GUI representations of the Parameter Values.

Type Values The possible values that may be assigned to the parameter, in the form

<{parametername>=<value>. Values are separated by a semicolon.

Parameter Value |Default value for the GUI representation, must be one of the values listed in the Type

Values field.

Global

Flag for the parameter value. True (default) means the parameter value is for all IDL files,
false means the parameter value is IDL specific (stored in IDL properties).

Parameter Values

Parameter “types” are GUI representations of the parameter values in the IDL properties tab for
this Custom Wrapper. They can be:

Entry

Purpose, Usage

Check box

Will draw a check box in the Custom Wrapper IDL properties tab. Type Values must have
two values, separated by a semicolon. The first value is taken if the check box is checked, the
second value is taken if the check box is cleared.

Combo box

Will draw a combo box (drop-down list) in the Custom Wrapper IDL properties tab. Type
Values must have at least one entry, or multiple entries separated by semicolon. An entry may
be:

“"_rsr

® asimple string (without the character), which is displayed as an entry in the box and is
sent to the Software AG IDL Compiler.

® apair "<val>=<{string>", where <string> is displayed in the combo box, but <val>is
sent to the Software AG IDL Compiler.

Constant

Will not generate a GUI element in the associated IDL properties tab. Type Values just has
one string, which is sent to the Software AG IDL Compiler.

Text

Will show a text field in the associated Custom Wrapper IDL properties tab. The text field
content is taken for the Software AG IDL Compiler command line construction. If whitespace
characters are typed in the text field, the Software AG IDL Compiler command line portion is
protected by double quotes. Type values may contain a string representing as default value
for the text field.
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Wildcards

Wildcards start with the % (percent sign). Implemented wildcards:

tab.

Wildcard Name Purpose Example Value
%brokerid Get the Broker ID from the General tab. |localhost:1971
%server Get the server address from the General | RPC/SRV1/CALLNAT

General tab.

%serverclass Get the server class identifier from the |RPC
General tab.

kservername Get the server name from the General [SRV1
tab.

%service Get the service identifier from the CALLNAT

sidlfile

Get the current IDL file (as absolute path
name) as selected in the EntireX
Workbench.

C:\Examples\example.idl

%idlname

Get the current IDL file (just the file
name with extension, no path) as
selected in the EntireX Workbench.

example.idl

spureidliname

Get the current IDL file name without
path and without the file extension.

example

%idlpath

Get the current IDL file path (without
the IDL file name) as selected in the
EntireX Workbench.

C:\Examples

%Zxmlfile

Get the current XML mapping file name
from the XML tab.

C:\Examples\ example.xmm

Zmsdotnetenv

Path of Microsoft Visual Studio
environment as set in the Tools Options
menu item.

C:\Program Files\ Microsoft Visual Studio 10
\Common7\IDE\

%netfrmdir

Path for installation of the NET
framework.

C:\WINDOWS\ Microsoft. NET\ Framework\
v2.0.50727

taken from the Java system property
os.arch.

%version Get the EntireX version. 8.0

sosname Get the operating system name, taken |Windows XP
from the Java system property os.name.

%osarch Get the operating system architecture, |x86

%osversion

Get the operating system version, taken
from the Java system property os.version.

5.1

»fileseparator

Get the platform-specific file separator
character, taken from the Java system
property file.separator.

EntireX Workbench
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Wildcard Name

Purpose

Example Value

%fileencoding

Get the platform-specific file encoding,
taken from the Java system property
file.encoding.

Cp1252

spathseparator

Get the platform-specific path separator
character, taken from the Java system
property path.separator.

taken from the Java system property
user.home.

ktusername Get the current user name, taken from |administrator
the Java system property user.name.
%tuserhome Get the assigned user home directory, |C:\Documents and Settings\administrator

suserdir

Get the current user directory, taken

from the Java system property user.dir.

C:\Documents and Settings\ administrator\ My
Documents

» Duplicate an existing Custom Wrapper

1  Select the Custom Wrapper in the list.

2 Proceed as described in Creating a New Custom Wrapper and press the Duplicate button
instead of the Insert... button.

A new Custom Wrapper named Copy of <name> is displayed in the list.

3 Modity the entries as described in Creating a New Custom Wrapper.

» Edit an existing Custom Wrapper

1  Select the Custom Wrapper in the list.

2 Proceed as described in Creating a New Custom Wrapper and select the Edit... button instead
of the Insert... button

3 Modity the entries as described in Creating a New Custom Wrapper.

» Remove an existing Custom Wrapper

1  Select the Custom Wrapper in the list.

2 Use the Remove button

» Migrate an existing .plugin File from a previous EntireX Installation

1  Proceed as described in Creating a New Custom Wrapper and select the Migrate... button
instead of the Insert... button.

2 Browse to the location of the .plugin file and select the file to migrate.
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3 Inthe ensuing dialog, modify the entries as described in Creating a New Custom Wrapper.

4 Make sure the template file can be accessed correctly.

Running a Custom Wrapper

» To start the Custom Wrapper in GUI

1 Select an IDL file.

2 Open the context menu, choose Other > Generate Via Template and select the desired item
(for example, New).

When the Custom Wrapper is started, the EntireX Workbench starts the Software AG IDL Compiler
and feeds it with a template, the IDL file name and (optional) parameters.

The parameters are inserted for the Software AG IDL Compiler in the form
<parametername>=<value>.If wildcards were used for the values, they are resolved to the actual
values when the Custom Wrapper was called.

» To start the Custom Wrapper in Command Line

»  See Using the EntireX Workbench in Command-line Mode for the general syntax of the command
line.

The command for the Custom Wrapper is - xxx, where xxx is the case-sensitive name of the Custom

Wrapper. If the name contains blanks, use - " xxx".

Example:

-NEW /Demo/example.id]l

The result of the Custom Wrapper is written to Standard Out.
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8 Using the EntireX Workbench in Command-line Mode

B Command LiNe UNGEr WINAOWS .. ...t e
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The EntireX Workbench can also be used from a command line. The command entered depends
on your operating system.

" Under Windows, the command line is available with the starter workbench.bat.
® Under Linux, the command line is available with script workbench.bsh.

® Under both operating systems, the command line is also available with the command for Eclipse
using the Java Runtime.

In all alternatives, a command is followed by a list of file names and a list of options. The file names
may contain an asterisk (*) as a wildcard. The options are key-value pairs, where the key starts
with a hyphen. The command selects the Wrapper or Extractor to use. The detailed options for
each command are described in the respective Wrapper or Extractor section. Using -help as
command lists all available commands with a short description. Using -help <command> lists the
options of the command.

For a detailed description of each Wrapper or Extractor, see the documentation of this component.
Throughout these detailed descriptions we use <workbench>as a general placeholder for the actual
starter of the Workbench. This can be workbench.bat, workbench.bsh, or the Eclipse starter.

Command Line under Windows

Enter the following command, replacing <£ntireX HOME>with your EntireX installation directory:

<EntireX HOME>\bin\workbench.bat <command> [ <file> [ <file> ... 1 1 [Koptions>]

This is the preferred method to start the EntireX Workbench. Alternatively, you can start the EntireX
Workbench with

"ZECLIPSE_HOME%\eclipsec" -application
com.softwareag.entirex.ide.eclipse.EntireXCommand -data %ZWORKSPACE% -nosplash
<command> [ <file> [ <file> ... 1 1 [Koptions>]

where ECLIPSE_HOME is the Eclipse installation directory
WORKSPACE is the Eclipse workspace directory.
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Command Line under Linux

Enter the following command:

/opt/softwareag/EntireX/bin/workbench.bsh <command> [ <file> [ <file> ... 1 ]

[<options>]

or

eclipse -vm $ECLIPSE_HOME/bin/ -application
com.softwareag.entirex.ide.eclipse.EntireXCommand -data $WORKSPACE -nosplash

<command> [ <file> [ <file>

1 1 [<options>] -vmargs

-Dentirex.license=/opt/softwareag/EntireX/common/conf/LKey/exx96.xm]l

where ECLIPSE_HOME is the Eclipse installation directory

WORKSPACE

List of all Commands

is the Eclipse workspace directory.

Command Description Syntax / Examples
-c:client Generate an RPC client from an IDL file. Using the C Wrapper in
-c:server Generate an RPC server from an IDL file, |Command-line Mode

-cobol:client

Generate a COBOL RPC client from an IDL
file.

Using the COBOL Wrapper
in Command-line Mode

-cobol:server

Generate a COBOL RPC server from an IDL
file.

-dcom:generate

Generate the DCOM Wrapper object(s) for
the specified IDL file(s).

Using the DCOM Wrapper in
Command-line Mode

-ejb:generate

Generate the EJB sources for the specified
IDL file(s).

Using the Wrapper for E|B in
Command-line Mode

-deploy:cobol

Deploy server-side mapping files
(Workbench file with extension .svm) to the
specified environment. See Server Mapping
Files for COBOL.

Command-line Mode

-extract:natural

Extract the Natural sources or objects from
a Natural RPC Server.

Using the IDL Extractor for
Natural in Command-line

Mode
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Command

Description

Syntax / Examples

-extract:pli

Extract the PL/I sources from an RPC
Extractor Service.

Using the IDL Extractor for
PL/I in Command-line Mode

-extract:wsdl

Extract an IDL file and an XMM file from a
Web service.

Using the IDL Extractor for
WSDL in Command-line
Mode

-extract:xml

Extract an IDL file and an XMM file from an
XML Document.

Using the IDL Extractor for
XML Document in
Command-line Mode

-extract:xsd

Extract an IDL file and an XMM file from an
XML Schema.

Using the IDL Extractor for
XML Schema in
Command-line Mode

-help List the short description of all commands.

-java:all Generate all Java source files for the specified | Using the Java Wrapper in
IDL file(s). Command-line Mode

-java:allbeancompliant Generate all Java source files for the specified

IDL file(s). The client object will be
JavaBean-compliant.

-java:client

Generate the Java client(s) for the specified
IDL file(s).

-java:clientbeancompliant

Generate the JavaBean-compliant Java
client(s) for the specified IDL file(s).

-java:server Generate the Java server(s) for the specified
IDL file(s).
-java:tester Generate the Java client(s) and tester(s) for
the specified IDL file(s).
-list:natural List the Natural sources or objects from a  |Using the IDL Extractor for
Natural RPC Server. Natural in Command-line
Mode
-list:pli List the PL/I sources on an RPC Extractor |Using the IDL Extractor for
Service. PL/I in Command-line Mode
-map:soap Create SOAP-conformant XML mapping for | Using the XML/SOAP

all programs.

-map:xmlattributes

Create attribute-preferred XML mapping for
all programs.

-map:xmlelements

Create element-preferred XML mapping for
all programs.

-map:xmlwithxsd

Create element-preferred XML mapping with
XML Schema for all programs.

Wrapper in Command-line
Mode

-natural:client

Generate Natural RPC client from the
specified IDL file.

-natural:server

Generate Natural RPC server from the
specified IDL file.

Using the Natural Wrapper in
Command-line Mode
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Command Description Syntax / Examples
-pli:client Generate a PL/I RPC client from the specified | Using the PL/I Wrapper in
IDL file. Command-line Mode
-pli:server Generate a PL/I RPC server from the
specified IDL file.
-version Prints the version and exits.
-wsdl Generates WSDL for the specified IDL file(s). | Using the Web Services
Wrapper in Command-line
Mode
-xml:sample Create sample XML documents for all Using the XML/SOAP
programs. Wrapper in Command-line
Mode
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9 Storing IDL Properties in an External File

When archiving an EntireX project with the export feature of Eclipse or the check-in feature of a
revision control system such as Subversion or CVS, you can use an external properties file to store
the properties of your IDL files. These properties are restored from this external file when the
project is imported or checked out.

| Note: This feature is not the default behavior and must be enabled for source and target

environment as described below.

» To enable the creation of external properties files

1  Start EntireX Workbench and choose Window > Preferences > Software AG > EntireX and
check the box Use external properties file....

2 Modity the properties of your IDL file. If you make any changes to default values, these
changes will be stored in a properties file with the name <name>.idl.xml.

When you archive your EntireX project using the Eclipse or a revision control system, make sure
the external properties file is included for every IDL file. When you recreate your EntireX project
in the same or a different environment, the properties of the IDL file are restored from the external
properties file. In the target system, the box Use external properties file... must also be checked.
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r

Y
= Preferences

— .

@

General

Ant

Centrabite

Data Management

Help

Install/Update

Java

lava EE

Java Persistence

JavaScript

Plug-in Development

Report Design

Run/Debug

Server

Software AG
Ajax Developer
Code Generation
Construct

Document Expansicn

Entirex
External Tools
| m |

General EntireX IDL preferences to specify the Broker ID and the Service Description
(Class, Server, Service) that are used in the varicus EntireX Wrappers.

LUse the properties pages of an IDL file to overwrite these preferences,

localhost: 1971

Server Name:

[ Use external properties file to store the IDL properties (for export/import)

[ Restore Defaults ] [ Apply l

|| cancel |
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